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Abstract 

The Additive Manufacturing Metrology Testbed (AMMT) is a fully customized laser powder 
bed fusion (LPBF) additive manufacturing (AM) research platform designed and constructed 
at the National Institute of Standards and Technology.  This system incorporates a 
galvanometer (galvo) scanner, consisting of two mirrors which can be controlled to rotate 
over fixed angles and reflect and position a focused, high power laser onto a substrate.  This 
Technical Note describes the methods for calibrating the quasi-static position of the laser 
spot, positioned via the galvo, as a function of the digital command to the galvo controller.  
In addition, the procedures for calibrating the galvo position encoders to the physical laser 
spot position are provided.  An example is provided of measured galvo position errors before 
and after calibration and compensation. Finally, an error reporting and uncertainty budget is 
provided. 

 

Disclaimer 

The procedures outlined in this document are provided solely as reference to current methods 
employed on an experimental apparatus at NIST.  Readers should note, these procedures 
reflect only the current methods employed by NIST, which may be further improved or 
amended.  Readers should not interpret the procedures in this document as a standard or best 
practice nor refer to this document as such. 
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 Introduction 

The Additive Manufacturing Metrology Testbed (AMMT) is a fully functioning laser powder 
bed fusion (LPBF) research platform, which includes a myriad of in-situ sensors and 
instrumentation for studying LPBF process physics.  The AMMT has fully customized 
controls that utilizes a 2D galvanometer (galvo) based laser steering system consisting of two 
rotating mirrors with approximately orthogonal axes, which position the focused laser spot at 
specified locations in X and Y coordinates on the build plane.  Yeung et al. provides more 
details on the controller implementation and characterization of various aspects including 
dynamic performance, synchronization with other AMMT systems, and complex laser/galvo 
positioning control  [1, 2].  Additionally, Yeung et al. described an experimental in-situ 
method for calibrating the position of the laser/galvo system which has potential for 
automation and more rapid calibrations [3].  However, at the time of publication of this 
document, that system has not been developed beyond the experimental stage.   

This document describes the methods for calibrating and compensating1 the positioning 
errors of the laser galvo system via the AMMT controller, and aims to accomplish the 
following:  

1) Accurately position a focused laser spot on the build plane at specified or 
commanded locations provided to the AMMT controller 

2) Calibrate the galvo encoders to read out the accurate laser spot position in length 
units  

3) Through the calibration process, establish the machine coordinate system’s X and 
Y axes and origin 

4) Define metrics for quantifying and comparing galvo positioning errors 
5) Demonstrate the results of an example calibration and compensation procedure 

 

A schematic of the AMMT galvo control system is shown in Fig. 1, which demonstrates the 
conversion of commanded scan positions to final, physical scan positions.  These conversions 
depend on user-determined calibration functions, which are incorporated into the digital 
galvo control system, or the electromechanical system itself.  

 

Fig. 1: Schematic of the galvo system control flow and calibration functions for X 
positioning and X encoder readout (same schematic could be made for Y). 

The general goal of the galvo calibration is to measure the quasi-static positioning errors, 
then define and apply compensation functions that mimic the physical plant shown in Fig. 1, 

 
1 The terms for ‘calibration’ and ‘compensation’ used here are based on terminology.  The International Vocabulary of Metrology (VIM) 
[4], recommends ‘correction’ instead of ‘compensation, While the VIM principally describes metrology systems (values are read from and 
instrument), the terms are also applied here to the control system (values are sent to an instrument to execute). 

Commanded 
Position

Xcmd [mm]

Digital 
Command 
Xcms [DL]

Galvo position 
θx [deg] Laser spot position on build plane

Xmeas [mm]Calibration 
function(s)

Galvo
Controller / 

Motors

Mirror/Laser 
Position 

Kinematics

Physical Plant

Encoder
Xenc [V]

Calibration 
function(s)

Encoder
Xenc [mm]
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and equates Xmeas = Xcmd , or Xmeas = Xenc.  For the galvo position command, this is done by 
creating physical marks with the laser on a substrate, and measuring their physical geometry 
or position.  This procedure is colloquially called the ‘mark and measure’ procedure [5]. 
Comparing the commanded galvo positions defined in digital levels [DL], and the measured 
positions enables construction of calibration functions XDL [DL] = f(Xmeas [mm]), which 
essentially mimic the ‘Physical Plant’ shown in Fig. 1, and are used to then convert 
commanded physical position Xcmd in millimeters [mm] into the galvo digital commands 
XDL,. This practice can be used to both develop new calibration functions, or measure 
positioning errors of a current calibration.  Similarly, galvo encoders provide an analog 
output voltage that can be read by a data acquisition (DAQ) system, an related to the galvo 
position.  The mark and measure process can be used to generate a calibration function Xenc 
[mm] = f(Xenc [V]), which converts measured encoder position in volts [V] into physical 
position in millimeters [mm].  The encoder signals are then useful to determine if there is any 
following error between the commanded position Xcmd and the real positions executed by the 
galvo and galvo controller.   

Multiple methods and strategies exist for positional calibration of a laser-galvo system, some 
of which would likely result in an improvement in precision from the procedure outlined 
here.  These typically employ a ‘mark and measure’ approach, where the laser is steered to 
create marks on a substrate (typically either coated glass [5] or anodized metal [6, 7]), then 
the geometry or positions of those marks, are measured using an offline dimensional 
measuring system to establish the galvo positioning errors and any error compensation 
necessary.  While in-situ methods have been demonstrated on the AMMT [3], the general 
‘mark and measure’ concept is demonstrated here by creating physical marks, then 
measuring their true position against some external dimensional scale, which achieves 
sufficient level of galvo relative positioning accuracy required by the AMMT.  This required 
relative accuracy is generally defined as better than 10-3 mm/mm (e.g., accurate positioning 
within 100 μm over a 100 mm span), or < 0.1 %.  Note that for commercial systems making 
production parts on much larger build areas (2502 mm2 is typical, compared to AMMT’s 
1002 mm2), the positioning accuracy requirements are likely more stringent. 
 

 Calibration Procedures 

The following lists the general steps in the AMMT galvo calibration procedure: 
1) Obtain a 100 mm by 100 mm sheet of black anodized aluminum plate, and place 

it in the AMMT build chamber, ensuring the z-height position is at the defined 
build plane height (0.70 mm above the reference mark). 

2) Turn on a flow of argon, close the AMMT build chamber, and execute the 
“Calibration Mode” on the AMMT controller to mark a dot grid pattern on the 
anodized plate.  Collect the galvo digital command values and galvo encoder 
signal values as part of the “DAQ file” while performing the mark. 

3) Remove the marked dot grid and scan it in a calibrated flatbed scanner (the 
external dimensional scale) at a high resolution (4800 dots per inch, or 5.3 μm per 
pixel). 

4) Using ImageJ software, measure the center of mass (CoM) locations for each dot. 
5) Begin formulating the calibration spreadsheet, and orient and translate the 

measured dot mark positions to establish the machine X and Y coordinates. 
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6) Finish the calibration spreadsheet by adding galvo encoder values extracted from 
the DAQ file, and calculate the calibration functions and calibration error. 

7) Optional: Apply the new galvo position calibration functions back into the 
AMMT controller, and repeat steps 1-6 to measure the residual galvo positioning 
error. 

 
2.1. Steps 1-2: Marking the calibration plate 
 
Select a black-anodized 5005 aluminum plate (McMaster-Carr2 Part# 6062K1), cut to 
approximately 100 mm by 100 mm.  Mark the plate with the date and arrows indicating the 
nominal X and Y orientation.  Place it in the AMMT build well, and measure the plate using 
the recoater-mounted profilometer.  First, position the profilometer spot adjacent to the Z-
height reference mark (a small indent approximately 1 cm to the left of the build well) and 
zero the profilometer, or note the indicated position.  Then move the profilometer over the 
approximate center of the calibration plate and position the build plate mechanism via the 
AMMT controller until the calibration plate is 0.70 mm above the z-height reference mark 
(see Fig. 2).  This position (0.70 mm above the reference mark) has been established by the 
AMMT designers as the ‘build plane height’, at which many other measurements are taken or 
the recoater blade is set prior to a 3D build. Ensure an enclosure with gas connection and 
clean laser window is in place. Run approximately 20 L/min of argon gas into the enclosure. 
 

  
Fig. 2: Calibration plate put into AMMT, including enclosure with laser window. 

 
2 Certain commercial equipment, instruments, or materials are identified in this paper in order to specify the experimental procedure 
adequately. Such identification is not intended to imply recommendation or endorsement by the National Institute of Standards and 
Technology, nor is it intended to imply that the materials or equipment identified are necessarily the best available for the purpose. 

Recoater-mounted 
laser profilometer

AMMT z-height 
reference mark

Enclosure + 
Ar gas line

Calibration 
plate

Laser
window
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Close the AMMT chamber.  Start the ‘Calibration Mode’ in the controller software, as shown 
in Fig. 3, under ‘Advanced Tools’ menu.  This adds several buttons and indicators to the 
main AMMT controller front panel, including a large indicator light in the lower left to show 
the system is in galvo calibration mode.  Ensure the laser is engaged (E-stop off, laser 
console green button ‘on’, red warning light flashing).  Click ‘execute’ to fire the laser and 
mark the plate. 
  

 
Fig. 3: Screenshot of the 'calibration mode' on the AMMT controller. 

A series of points will be marked with the laser as shown in Fig. 4, with the laser turned off 
while traversing from point to point.  Each point consists of the laser holding a static position 
for 100 ms at approximately 15 W power.  Note that one of the points near the end is 
missing.  This helps ensure that the XY alignment of the dot pattern is distinguishable when 
the calibration plate is removed from the chamber.  The AMMT data acquisition (DAQ) 
system incorporates multiple analog to digital (A/D) converter channels.  Two of these 
channels sample the voltage output signal from the galvo encoders at 100 kHz.  During the 
calibration scan, the DAQ should have recorded the galvo encoder signals, as well as any 
other connected channels, and saved them on the AMMT controller. 
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Fig. 4: Positions and ordering of the 7×7 grid of mark marks executed in the AMMT galvo 

calibration routine. 

The galvo encoder positions, collected as timeseries data, needs to be converted into average 
values in [V] over the duration that the laser is marking each point.  This is done by running 
the separate ‘XY Calibration Routine.vi’ virtual instrument (VI) shown in Fig. 5 , which 
performs this averaging and exports the required data in a CSV file.  Run the ‘XY 
Calibration Routine’ VI, and supply it the DAQ file that was generated during the scan.  Save 
the generated CSV file. 
 

 
Fig. 5: XY Calibration Routine virtual instrument front panel, showing the commanded 

positions (Xc, Yc) in [mm], digital positions (XD,YD) in digital levels, encoder voltages 
(X (V), Y (V)) in [V], and calculated encoder scaled positions (Xe, Ye) in [mm].  Note that at 

the time of publication, the column headers in the VI had not been changed to match those 
used throughout this document. 
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2.2. Steps 3-4: Measuring the calibration plate 
 
Carefully remove the calibration plate from the AMMT being careful not to scratch or leave 
fingerprints, and wrap it in a laboratory wipe for safe transport to the flatbed scanner.  
Carefully place the calibration plate face-down on the flatbed scanner.  The pixel pitch of the 
flatbed scanner is used as the dimensional reference scale for measuring the marked dots.  
The accuracy of this scale was verified against a calibrated target, described as the Scaling 
Factor in the uncertainty assessment in Section 4. In the scanner software, set the image type 
to 8-bit grayscale, and 4800 dots per inch.  Use the ‘Preview’ tool to run a quick (low 
resolution) scan.  In the preview window, use the marquee tool to draw a rectangle around 
the calibration grid, which reduces the area over which the scan is performed.  This should 
generate an approximately 19 000 pixel by 19 000 pixel image of 350 Megabytes. An 
example of a scanned image is shown in Fig. 6. 
 

   
Fig. 6: Example scanned image of a laser mark.  (a) Scanned image of full calibration plate. 
(b) Subset of (a) showing four laser marks. (c) Microscope image of the lower-left mark in 

(b) with 50 μm grid overlay. (d) Resulting image from flatbed scanner of the same mark  

Note that some of the laser marks may incur a deposit of spatter, which is nominally oriented 
in the direction the laser was scanning toward the point, as shown in Fig. 4. 
 

Laser mark

Spatter

a b

c

0.1 mm

5 mm

d
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The following steps are done to measure the locations of the marks after opening the image 
in ImageJ. 

1) Adjust the approximate origin of the image to the central dot:  Zoom in to the central 
dot using the (+) and (-) keys, and note the visually approximated center in pixels 
(listed under the ImageJ main window).  Under Image>Properties, set the origin to 
these values.  This reduces the offsets needed to later center and align the measured 
points, and allows the user to better identify if the scaling is as expected. 

2) Apply scaling: Under Analyze>Set scale, adjust the scaling to be 188.9764 pixels per 
mm (equivalent to 4800 dots per inch).  

3) Create list of regions of interest (ROIs) around mark points: Using the circle ROI 
tool, draw a circle around one of the marks, using (+) or (-) keys to zoom in and out.  
Once the first ROI is made, type ‘t’ to add it to a list in the ROI Manager.  Repeat for 
all the marks. 

4) Measure the centers of mass: Under Analyze>Set Measurements…, click on ‘Center 
of Mass’.  Click on ‘Invert Y coordinates’ to ensure the image coordinate origin is in 
the lower left, then close the window.  Click ‘Measure’ on the ROI manager, and a 
table of measurement results will appear with the CoM within each ROI listed as 
shown in Fig. 7.  Save this table.    

 

 
Fig. 7: Steps for measuring dots on the calibration plate. a) Example setting the image scale. 
b) Main window displaying the scanned plate and ROIs. c) Magnified image showing a 
circular ROI around a mark. d) List of ROIs in the ROI manager. e) Example CoM 
measurement results table. 

2.3. Steps 5-6: Calculating the calibration functions  
 
Calculations are conducted using commercial spreadsheet calculation software, although any 
calculation and plotting software is sufficient.  Arrays are copied from their respective 
sources (e.g., measured points or DAQ data), and put into columns in the spreadsheet as 
shown in Fig. 8.  First, the target commanded scan positions, as shown in Fig. 4, are copied 
to the first two columns.  It is important to keep the ordering of the XY pairs consistent 
between data sources.  This can be specified in Excel1 by clicking 

a)

b) d)

c)

e)
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Sort & Filter>Custom Sort…, then sorting X column smallest to largest, followed by Y 
column largest to smallest.  This should also be done for the encoder measurements from the 
DAQ output file and the scanner measurements prior to copying to the main calculation 
sheet. 
  

 

 

Fig. 8: Example section of the calibration calculation spreadsheet, including what each 
column data represents and how it is obtained. 

Since the relative orientation of the calibration plate with respect to the galvo position is lost 
when the plate is removed from the machine, the measured points will need to be oriented 
and translated to coincide with the definition of the machine X and Y axes (defined in detail 
below).  Machine axes are indicated by the superscript ‘A’ to differentiate from other axes.  
To rotate and center the grid pattern of the measured points, the measured points along the 
center horizontal row are selected, which coincide with X-values when ycmd = 0 [mm].  A 
regression line is then calculated through these points, as shown in Fig. 9.  The y-offset, y0, is 
identified as the y-intercept, and rotation angle θ in radians [rad] as the slope. 
 

 
Fig. 9: Best fit line through (x,0) measured points.  Y-offset (y0) is found to be 0.03303 mm, 

and rotation angle θ = atan(0.06218) = 0.06210 rad. 

Xcmd_mm Ycmd_mm Xcmd_DL Ycmd_DL Xenc_V Yenc_V Xmeas_mm Ymeas_mm Xmeas_rot Ymeas_rot Xerr_mm Yerr_mm Xerr/X Yerr/Y
-37.5 37.5 24426 27151 1.227 0.840 -36.915 37.434 -36.996 37.339 -0.504 -0.161 -0.013 -0.004
-37.5 25 24426 29484 1.227 0.504 -36.973 24.968 -37.031 24.873 -0.469 -0.127 -0.013 -0.005
-37.5 12.5 24426 31817 1.227 0.166 -37.042 12.559 -37.077 12.464 -0.423 -0.036 -0.011 -0.003
-37.5 0 24426 34150 1.228 -0.170 -37.093 0.126 -37.106 0.031 -0.394 0.031 -0.011 0.031
-37.5 -12.5 24426 36483 1.227 -0.511 -37.143 -12.302 -37.133 -12.397 -0.367 -0.103 -0.010 -0.008
-37.5 -25 24426 38816 1.227 -0.847 -37.200 -24.780 -37.167 -24.875 -0.333 -0.125 -0.009 -0.005
-37.5 -37.5 24426 41149 1.226 -1.184 -37.262 -37.238 -37.207 -37.333 -0.293 -0.167 -0.008 -0.004
-25 37.5 27212 27151 0.826 0.840 -24.540 37.317 -24.620 37.245 -0.380 -0.255 -0.015 -0.007
-25 25 27212 29484 0.827 0.504 -24.591 24.887 -24.649 24.815 -0.351 -0.185 -0.014 -0.007

These are the ‘target’ 
positions in [mm].  A 

good calibration should 
result in measured 

values equivalent to 
these.

These are the 
commanded digital 

positions in [DL].  
These values do not 

change.

These are the 
average encoder 

signals in [V] 
calculated in ‘XY 

Calibration 
Routine.vi’

These are the measured 
locations of each laser 
mark acquired using a 

spatially-calibrated flatbed 
scanner

The position 
deviations are the 

measured positions 
minus the 

commanded 
positions in [mm]

These table values are generated by 
the ‘XY Calibration Routine.vi’

These values are calculated based on 
previous columns

The relative 
deviations are the 
deviations divided 
by the commanded 

position in 
[mm/mm]

The measured positions 
in [mm] are rotated to 

align the x-axis 
horizontally, and 

translated to set the 
origin.

These values are generated from 
measurement of the laser marks

Non-oriented, as-measured 
laser marks

Select central, horizontal row and fit a line

tan(θ) y0
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The measured points are then shifted by y0 in the calculation spreadsheet to better align with 
the anticipated origin, then rotated based on Eqn. (1).  Note that points have not yet been 
centered in X, indicated by the asterisk on xmeas,rot* in Eqn. (1).  Results of the translation by 
y0, and rotation by θ are shown in Fig. 10, which shows the best fit line through the points 
(x,0) now closely intercept y = 0.   
 

�
𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚,𝑟𝑟𝑟𝑟𝑟𝑟 ∗
𝑦𝑦𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚,𝑟𝑟𝑟𝑟𝑟𝑟

� = �𝑐𝑐(𝜃𝜃) −𝑠𝑠(𝜃𝜃)
𝑠𝑠(𝜃𝜃) 𝑐𝑐(𝜃𝜃) � �

𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚
𝑦𝑦𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 − 𝑦𝑦0�𝑦𝑦𝑦𝑦𝑚𝑚𝑦𝑦=0

 (1) 

 
 

 
Fig. 10: Results of shifting by y0 and rotating by θ moves center horizontal points (x,0) to 

align with Ay=0 origin. 

The machine x-axis, Ax, is now established, as well as the origin point Ay = 0.  The x-offset, 
x0, is then determined by fitting a line to the central vertical points, (0,y), as shown in Fig. 11. 
 

 
Fig. 11: Best-fit line through central vertical points, (0,y), after translating to y0, and rotating 
by θ.  The intercept defines the x-offset, x0.  Note that the x and y axes are switched in this 

plot. 

This fit line may have a non-zero slope, which indicates the measured positions along this 
column of laser marks are non-orthogonal to Ax.  Finally, the points are translated one more 
time based on the measured x-offset, x0, to arrive at the final oriented and centered points, 
descried in Equation (2), with final results shown in Fig. 12.   
 

�
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Fig. 12: Results of shifting by x0 on the central vertical points (0,y).  The intercept of the 

best-fit line is now at A(0,0). 

The measured points along the central horizontal are now aligned with and define the 
machine x-axis Ax.  The fit line through the central vertical points determines the origin 
A(0,0) by its intersection with Ax, although it does not define the machine y-axis Ay.  The 
machine y-axis Ay is defined as being orthogonal to Ax and passing through A(0,0). Deviation 
of the fit line through the central vertical points from Ay indicates non-orthogonality error in 
the galvo system.  After all measured points are oriented and translated to the machine 
coordinates (xmeas,rot, ymeas,rot), they can be considered A(x,y). 
 
Once the data in Fig. 8 is compiled (excluding the error measurements, which are described 
in the next section), the calibration functions for the galvo positioning (Fig. 13) and galvo 
encoders (Fig. 14) can then be calculated using linear regression.  
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Fig. 13: Galvo calibration functions determined from mapping the measured points translated 

into machine coordinates A(x, y) in [mm] to the digital command (xcmd,ycmd) in [DL]. 

  
Fig. 14: Galvo encoder calibration functions determined from mapping the measured points 
in machine coordinates A(x,y) in [mm] to the measured encoder voltage levels (xenc,yenc) in 

[V] from the DAQ data. 
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Note that in the AMMT main front panel, the encoder positions are read out in real time.  
Sometimes, a non-zero offset is incurred in the encoder readout in [V], which can vary over 
time, causing a non-zero offset in [mm] to be read from the encoders.  If when the laser is 
commanded to move to a static position at the origin (0,0) and the encoders read some non-
zero offset, you can add or subtract that value in [mm] from the encoder calibration function.  
Since the encoder calibration equations in Fig. 14 are linear, this does not affect the scaling. 

 
2.4. Step 7: Galvo Positioning Error Compensation  
 
Once the galvo positioning calibration functions are calculated, such as those in Fig. 13, the 
slope and offset values from the calibration curve fits can be entered back into the AMMT 
controller.  After this is completed, steps 1 to 6 should be repeated, and the physical position 
of the laser marks measured once again.  If done correctly, this should reduce the difference 
between the commanded positions (Xcmd and Ycmd) in [mm], and the measured positions 
A(x,y) in [mm]. 

To verify that the correction has improved the galvo calibration, several metrics for 
calibration error are defined in the next section, which can be used to verify any 
improvement to the galvo calibration stemming from an applied correction. 

 Error Reporting and Example Calibration and Compensation Results 

One component of the positioning error, which is the error between the true and commanded 
positions, is the vector difference between the corrected locations A(x,y) and the commanded 
positions (x,y)cmd.  These error vectors can be plotted as a quiver plot, as in Fig. 15 where the 
vector difference is scaled 20× to demonstrate which direction and by how much the 
measured galvo errors exist.  This also provides a visual demonstration of how a 
compensation reduces the individual point deviations. 
  

 
Fig. 15: Example commanded points (+), measured points after rotation (o), and the vector 
difference between them (scaled 20×) for pre-compensated and post-compensated 
measurements, demonstrating improvement in positioning accuracy post-compensated. 
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While visually demonstrative, the vector error does not quantify how the galvo errors will 
‘dilate’ or ‘contract’ a part build at a specific location.  The deviation for each point is 
calculated as Ex = |Xmeas,rot|-|Xcmd| in [mm], and similarly for Ey.  This definition using 
absolute values ensures that positive Ex or Ey results indicate ‘dilation’ of that point away 
from the origin, and negative errors indicate ‘contraction’ of that point towards the origin.  
The deviation values for all measured laser marks are plotted in Fig.16 vs. the commanded 
position prior to and after a compensation.  While still demonstrative of the deviation-
reducing effect after compensation, a singular metric should be defined for the positioning 
error that is the aggregate of individual deviations over the entire positioning range. Here we 
define this mean deviation as the mean deviation of all Ex and Ey values.  For example, a 
positive average Ex means the galvo tends to erroneously dilate in the X direction.  The mean 
Ex and Ey are provided in the tables in Fig.16.   
 
Another metric is the relative positioning error.  If the scaling (slope) of the calibration 
curves in Fig. 13 is erroneous, the scale of the Ex and Ey errors will tend to increase with 
positions further from the origin (i.e. the total field of points is dilated or contracted).  
Similarly, a part fabricated with smaller dimensions will tend to have small absolute 
geometric error compared to a large part.  The deviation of a single point can be normalized 
by its relative distance from (0,0), such as Ex/Xcmd to form the relative deviation of that point.  
Taking the mean of all relative deviation values provides another singular metric for the total 
relative positioning error in each direction, and is demonstrated in the tables in Fig.16.   

 

 
Fig.16: Example errors Ex and Ey before compensation (left) and after compensation (right).  
After compensation various error metrics are reduced, as shown in the tables at the bottom of 

each figure. 
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Ex (mm) Ey (mm) Ex /X Ey /Y
Mean 0.0224 -0.0004 0.011% -0.061%
St.Dev. 0.102 0.102 0.019 0.013

N 48 48 48 48
u = s/sqrt(N) 0.015 0.015 0.003 0.002

Ex (mm) Ey (mm) Ex /X Ey /Y
Mean -0.2433 -0.1173 -1.030% -0.517%
St.Dev. 0.161 0.086 0.015 0.009

N 48 48 48 48
u = s/sqrt(N) 0.023 0.012 0.002 0.001
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The relative deviations, Ex/X and Ey/Y, defined at each measured point, are useful to 
describe how much the system may dilate or contract a part or feature built at that specific 
location, relative to the features planned or commanded dimensions. Larger features will 
incur larger deviation.  For example, a thin-walled cylinder may incur a large absolute 
deviation of its outer diameter, but the wall thickness may incur a slight deviation due to its 
relatively smaller dimension.  All the points that make up Ex/X and Ey/Y are analogous to a 
strain field.  Positive relative deviation indicates feature dimensions are dilated in that 
direction and magnitude with respect to the planned geometry.  Negative relative error 
indicates features are contracted in that direction.   

The mean relative deviations give a single metric for how much the galvo errors generally 
dilate or contract parts in each direction.  For example, in Fig.16, the post-compensated 
measurements resulted in general dilation of 0.019 % in the X-direction and general 
contraction of 0.147 % in the Y-direction.  The relative positioning errors describe the mean 
positioning accuracy, which is less than the 0.1 % desired accuracy for the AMMT in the X-
direction, and slightly greater than 0.1 % in the Y-direction.  However, these metrics 
incorporate the residual positioning errors prior to or after calibration and compensation, any 
unknown deterministic or stochastic errors, as well as measurement error associated with the 
mark and measure procedure.  This is discussed further in Section 4: Measurement 
Uncertainty.  

Another error metric described by Godineau et al. utilizes the cumulative distribution 
function (CDF) formed from the vector sum of the errors (|E| = √ Ex

2+Ey
2) [8].  This removes 

indication of how the galvo dilates or contracts points.  However, the vector-sum CDF can 
tell how much of the measured field (in %) has an error less than a certain value.   For 
example, Fig. 17 shows that 90% of the scan area had |E| < 0.41 mm pre- compensation, but 
90 % of the area had |E| < 0.115 mm post- compensation.   
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Fig. 17: Top: Example heat map of the vector sum error from pre- and post- compensation 
measurements, fit with a 4rd order two-dimensional polynomial, and sub-sampled to a 1 mm 
grid.  Bottom: Cumulative distributions of the sub-sampled vector-sum errors |E|. 

 
 Measurement Uncertainty 

While various error metrics have been described, this section focuses on the mean 
positioning error Ex, Ey values in Fig.16.  These are the measurands of interest, and the 
measurement uncertainty described here details how well these values are measured using the 
mark and measure method. A summarization of the uncertainty evaluation is provided in and 
summarized in Table 1 at the end of this section. 

The measurement uncertainty of the mean error values are organized into three categories: 1) 
the physical marking setup and execution 2) the capture and measure of laser mark images 
and image processing 3) the calculation of error from the measured points.  The following 
components of uncertainty are considered:  

Z-positioning of plate describes the effect of positioning the calibration plate within the 
AMMT.  Since the laser approaches the plate at an angle, any misalignment of the calibration 
plate surface with the expected build plane in the Z-direction will induce lateral positioning 
errors in X or Y.  This may stem from poor flatness of the calibration plate, non-parallelism 
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with the build plane, or incorrectly positioning the calibration plate in the z-direction.  The 
AMMT laser forms a maximum angle of 7.8 ° from the surface normal within the calibrated 
area (±37.5 mm from center) [9].  Therefore, a deviation in Z of the calibration plate by δz 
will elicit a maximum lateral deviation in X or Y by δx = δz⋅tan(7.8°).  Although efforts are 
taken to parallelize and set the calibration plate to the specified build plane in the AMMT as 
described in Section 2, some positioning error may occur.  The effect of this error on the 
galvo positioning will most likely not be random, but systematic.  However, for simplicity, 
we assume a maximum deviation of δz < ±0.05 mm (Type B estimate), with assumed 
triangular distribution since 7.8° is the maximum laser angle. Then,  δx or δy will be 
< ±0.007 mm, and uncertainty u1 = δx/√6 [10]. 

Physical mark CoM matches laser spot center refers to the possibility that the CoM of the 
physical mark’s image does not actually align with the center of the laser spot when it was 
created.  This primarily stems from two factors: 1) The formation of the mark may be skewed 
by the physical marking process potentially stemming from molten pool sloshing, asymmetry 
of the laser energy profile, effect from the laser incident angle, positional noise/vibration of 
the laser spot, etc. 2) The image of the spot is not rotationally symmetric due to its inherent 
shape and structure, which elicits variability in the measured CoM.  These factors are 
assumed to contribute variability less than 10 % the average diameter of the marks, or 
roughly ± 0.01 mm.  Assuming normal distribution, Type B, u2 = 0.01 mm.     

Thermal errors incorporate any change in the aluminum plate dimensions due to thermal 
expansion between the marking process and measurement process.  This may come from 
difference in ambient conditions, heat accumulation from handling, or heat accumulation 
during the marking process.  Aluminum has a coefficient of thermal expansion (CTE) of 
approximately 24×10-6 m/m/K, meaning a 1 °C change in temperature would yield a 2.4 μm 
change in the aluminum plate length.  Careful handling and controlled lab environments can 
likely reduce temperature differences to < 1 °C. However, laser heating during the marking 
process does introduce a nontrivial amount of heat.  Assuming all the laser energy during 
marking is absorbed and converted to heat energy in the plate, and assuming no heat loss 
(adiabatic), the laser pulses of 100 ms with 15 W amount to a total marking time of 4.8 s, and 
total energy input of 72 J.  Plate mass (density × volume) is (0.00271 g/mm3)×(1.016 mm × 
100 mm × 100 mm) = 27 g.  Specific heat for aluminum is approximately 0.9 J/g/K, which 
yields a temperature rise ΔT = q/mc = (72 J)/(27 g)/(0.9 J/g/K) ≈ 3 °C.  This heat 
accumulation is non-equilibrium (transient), accumulates with each laser mark, and also very 
localized to the vicinity of each laser mark.  The temperature rise at the instance of time 
during each mark will be < 3 °C.  We incorporate a very conservative estimate then that total 
temperature difference, from both environmental and laser marking effects, to be ≈ 3 °C, or 
max thermal error on the 75 mm grid to be (24×10-6 m/m/K)×(0.075 m)×(3 °C) = 5.4 μm.  
Assuming rectangular distribution, Type B, this yields u3 = 5.4 μm /√12 = 1.56 μm.     

User selection of ROIs pertains to effect that the actual size and position of a user-selected 
ROI in ImageJ will affect the calculation of the CoM which determines that mark’s location.  
To estimate this effect, 31 ROIs were made of one spot shown in Fig. 18, and the CoM 
calculated for each ROI.  This resulted in standard deviation of σx

 = 0.0085 mm and 
σy

 = 0.0096 mm.  Since this was only conducted for one spot, and by one user, this 
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uncertainty is assumed to be slightly greater than that measured in Fig. 18, or 0.010 mm 
(Type B, normal distribution).  

 

Fig. 18: Example ImageJ window showing 31 circular ROIs selected to test how varying the 
user-selected ROI size and location will affect the calculation of the spot’s CoM. 

Scaling factor is the length calibration of the flatbed scanner.  The scanner length calibration 
was verified using a dot grid reference artefact with vendor-stated precision of ± 1 μm.  At 
the 5.29 μm per pixel resolution used in the galvo calibration measurements, the artefact’s 
dot-to-dot spacing of 1 mm was repeatably measured to within ±1 μm, indicating the scaling 
accuracy of the scanner itself is on the same order or better than the reference artefact’s 
stated precision.  A worst-case scenario assumes the scanner length calibration to be 
< 0.01 %.  Over the 70 mm measured region, this results in u5 = 0.007 mm, with assumed 
normal probability distribution (Type B). 

Standard uncertainty of the mean is provided in the tables in Fig.16.  Since the number of 
samples, N > 20, this is defined by uμ = σ/√N; a Type A evaluation with normal distribution.  

Combined standard uncertainty is calculated using the root-sum-square of the standard 
components of uncertainty assuming no correlations [10], or uc = √ ∑ ui

2.  The expanded 
uncertainty, U, is the combined standard uncertainty multiplied by a coverage factor, k = 2, 
to define a level of confidence of approximately 95 %. 
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Table 1: Measurement uncertainty budget for the mark and measure procedure.  Uncertainty 
values are presented after any correction for non-normal (Gaussian) probability distribution. 

Category / Uncertainty Component Uncertainty Value 
[mm] Type Distribution 

Physical Measurement Ex Ey   

    Z-positioning of plate, u1 0.0028 0.0028 B Triangular 

    Physical CoM matches laser center, u2 0.010 0.010 B Normal 

    Thermal errors, u3 0.0016 0.0016 A Rectangular 

Scanned Image Capture     

   User selection of ROIs, u4  0.010 0.010 B Normal 

   Scaling factor, u5 0.007 0.007 B Normal 

Error Calculation (Post-compensation)     

Standard uncertainty of the mean σμ 0.015 0.014 A Normal 

Combined Standard Uncertainty, uc 0.022 0.021   

Expanded Uncertainty, U (k=2) 0.044 0.043   
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Appendix A: Supplemental Materials 

A Microsoft Excel spreadsheet (*.xlsx) file is available with two tabs/sheets that provide 
example ‘pre-compensation’ and ‘post-compensation’ measurement, calibration, plots, and 
measurement error calculations. 

The file is titled “GalvoCalibrationCalculationSheet.xlsx”, and is available at 
https://datapub.nist.gov/od/id/mds2-2257, with digital object identifier (DOI): 
https://doi.org/10.18434/M32257.  

 

https://datapub.nist.gov/od/id/mds2-2257
https://doi.org/10.18434/M32257
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